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QUBT U invites professors and students to experience quantum by solving constrained optimization 
problems using  QCI’s Qatalyst -- a highly sophisticated, quantum application accelerator for 
complex computations. With the help of Qatalyst, students will build the foundation necessary 
to apply mathematics to real world problems,  solving them with both classical and quantum 
constrained optimization. 

QUBT U students will solve their first quantum-ready problem within a day to a week using 
Qatalyst.  Instead of having to learn complex quantum programming and low level hardware 
coding to build a new quantum program, students focus on solving problems.  Students will also 
learn how to take a business/real-world problem and logically transform it into a math problem 
that’s needed to submit it to a quantum computer.  They can then solve that problem and apply 
the results to a real world scenario. QUBT U gives you more than just quantum exploration, we 
help you learn about applying quantum value.

QUBT U  includes training on Qatalyst as an alternative to months and months of complex quantum 
device programming and low-level coding. We provide the resources you’ll need to understand 
combinatorial optimization using both classical AND quantum computers. 

First, you’ll learn how to format and submit constrained optimization math problems to 
Qatalyst using the Quadratic Unconstrained Binary Optimization (QUBO) model.

Then, you’ll have the opportunity to learn how to transform every day optimization 
requirements into mathematical problems required to process on quantum computers. 

We’ll also offer more insights into quantum computers and quantum programming. 

Linear algebra background.

Working knowledge of mathematics and/or quantum mechanics and physics.

Programming skills: How to call functions in Python/access object attributes. How to create 
Numpy or Scipy matrices (optional).

The course runs in two parts:

Revolutionize your thinking. 
Experience quantum with QUBT U. 

Prerequisites for course work
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EDUCATION:
Explore quantum with zero quantum experience. Learn how to structure and submit complex 
optimization problems to quantum systems. 

COMPETENCIES & SKILLS:
Students will apply lessons learned at QUBT U in their future careers thanks to their baseline 
understanding of constrained optimization and quantum computing.

SUPPORT: 
Assistance through a QUBT U forum and a QCI-support email. 

CURRICULUM: 
Each semesters’ program offers students training and tutorial videos on sample problems. Students 
will be presented with 3 problems to solve  – 2 on classical using quantum techniques and a 3rd 
problem using Qatalyst with QPUs. You get hands-on experience with quantum computers and 
quantum-ready models like QUBO and algorithms like Quantum Approximate Optimization 
Algorithm (QAOA).

QCI founded QUBT U because we want students and professors to explore quantum to understand 
the commercial potential of quantum and help students hone their skills for careers that bring 
the impact of quantum to business. 

As Robert Liscouski, CEO of QCI says, “By giving students the opportunity to experience a simpler 
way to solve complex problems with quantum computers, we’re exposing them to a more effective 
method to take advantage of quantum powered technology.”

What You Get
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Quantum computing utilizes the science of quantum mechanics to deliver actual results in 
anything from combinatorial constrained optimization problems, to accelerating and improving 
the accuracy and diversity of results that a classical system cannot provide. 

Quantum software programming is critical to making quantum computers process actual results. 
In many ways, quantum programming is the bigger challenge as it requires a significant and new 
level of expertise -- expertise that classical programmers, Subject Matter Experts, and others don’t 
have. Thanks to QUBT U and Qatalyst, you’ll get to solve problems on quantum computers without 
having to become a quantum guru. 

Quantum computing is based on probabilities and multiple simultaneous truths rather than just 
1s or 0s (binary code) -- on or off. Quantum computing operates using ‘qubits’, which are vectors 
of 1s and 0s and can exist in a linear combination of both of these states at the same time, also 
called superposition. These outcomes are based on the moment in time when they are measured, 
and the probabilities present at that exact moment. There are many other key differences that 
differentiate quantum and make it a more powerful tool for finding some of the world’s most 
challenging solutions.

Quantum computing is a completely new paradigm for all of us. You may even have to forget what 
you’ve known about how computers process to step into the world of quantum. By abstracting some 
of the complex quantum notions, we aim to lower the threshold of entering the quantum world 
for everyone.

Here are a few tips to help you absorb quantum computing and its quantum mechanical principles. 

Introduction to 
Quantum Programming 

Tip #1: 
Pay attention to quantum buzzwords. In the world of quantum software, it can be difficult 
to navigate all the different terminologies used. Knowing the right buzzwords may just be 
exactly what you need to more easily understand the world of quantum.

Tip #2: 
Know the difference! There are fundamental programming shifts that take years to learn 
and execute before you can run a program on a quantum computer.  Even experts take 9 to 12 
months to create their first program. Which, btw, is why we created Qatalyst.  No quantum 
programming, just access to quantum-driven results in under a week.

Tip #3:
Be ready for everything new. Quantum is a non-intuitive topic that can very well change your 
perspective of the world. One of the beauties of quantum computing is that you get to rethink 
your assumptions about all the classical things people have accepted as the only way.
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For context, classical computing is ideal for linear tasks such as arithmetic, measurement, 
storage, etc; quantum is ideal for nonlinear, multivariate and/or repetitive tasks such as 
optimization problems. 

Take route optimization for example, the real question is multifaceted. Delivery services such as 
Amazon need to take into account parcels, the cost of gas when the tank is filled, cost to pay the 
employee, the level of irritation each specific customer experiences when a delivery is late, the 
likeliness of a customer to switch from Amazon to other vendors due to delivery tardiness, the 
specific customer profitability of each customer on route, and so on. The variables required to 
answer the question can be stored in a typical classical database. However, actually solving this 
problem quickly and efficiently is better suited to quantum computing.

So why does constrained optimization, specifically with quantum, matter?  

Quantum computers promise to solve problems that classical problems simply can’t finish today 
due to the increasing size of the search space and the complexity of constraints.  They also will 
solve problems faster, with more accuracy and a better set of results. You’ll get to see this value 
in action as part of QUBT U.
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Sampling electronic structure QUBOs with Ocean and Mukai solvers

QCI Qbsolv Delivers Strong Classical Performance for Quantum-Ready Formulation

Here are some reads that we highly recommend checking out on how to reap the benefits of quantum!

Qatalyst is a sophisticated, ready-to-run quantum software  for complex computations. It enhances 
classical computing performance and quality of results today, even as it offers a seamless bridge 
to quantum computing.  It submits the same exact problem to quantum and classical computers, 
including D Wave, IonQ and Rigetti via Amazon Braket, and a direct connection to IBM. With 
Qatalyst, you can use the same API function call (e.g., constrained optimization, community 
detection, etc.)  to solve  the same problem  on classical or diverse quantum computers, with no 
programming required.

Since Qatalyst eliminates the need for quantum expertise and complex programming that can 
take months to years for a single problem, it accelerates your time to quantum results for 
problems that can run on a quantum processing unit (QPU) today. While these are only very small 
problems due to the scale of QPUs, it is important to begin to learn about quantum computers 
right now so that we are ready to leverage their power when they scale to meet production 
problem needs.  Qatalyst provides a seamless bridge between classical and quantum with no new 
programming -- hence having quantum power, no complexity.

BACKGROUND
The reality today  is that quantum computers can’t scale to solve real-world problems, and most 
likely won’t scale to meet enterprise needs in the near term. That doesn’t mean you can’t start 
learning about quantum and using quantum systems for exploring their potential value. You can 
also learn the dramatic differences between quantum and our traditional computers.  

Introduction to Qatalyst
Quantum Optimization with no quantum programming required.
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Qatalyst Includes the following:
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In simple terms, constrained optimization guides you to decide how to do more with less, or how 
to use less to do more. It has long been a powerful approach to solve an array of problems using 
applied mathematics to drive better business decisions. Constrained optimization is a solution 
whenever there is a requirement to allocate or prioritize scarce or important resources within a 
dynamic and complex environment. 

Introduction to 
Constrained Optimization

Large buying decisions such as a new computer or even furniture, are often constrained by the 
requirement that we have to be able to afford what we buy.

Deciding how to prioritize study, work, play, travel, and more based on the constraints of your 
available time and income/budget.

Making decisions on the route you’ll drive based on an objective (your destination) and 
constraints (time, traffic, number of lights) applied to your variables (the optional routes).

You already use constrained optimization every day:

Companies often make manufacturing and packaging decisions so that they can maximize their 
profit margins, within the constraints of finite manufacturing or shelf space.

Retail stores minimize costs as they are related to the constraints of shelf space, availability, 
time to ship and more.

Employers seek to minimize payroll costs while maximizing customer satisfaction during peak 
seasons by optimizing holiday work schedules based on their objectives.

In an economic business decision setting:

In application, there are four mathematical aspects to any constrained optimization problem, 
which will be broken down in the coursework included in QUBT U as well. They are:

Constrained Optimization Basics

Decision Variables: 
The data you want to make optimal decisions about such as assets, materials, or routes, 
etc. Optimization problems may have a variety of variable types such as binaries, integers, 
continuous etc. 

1
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Knowing constrained optimization techniques will put you at an advantage in your future career, 
as it is a powerful way to improve your operational decisions and bottom-line results. QUBT U will 
help you in understanding the underlying math and how that translates into business variables, 
constraints, and objectives.

You can find more details about constrained optimization and its application, click here or 
subscribe to our Insights Blog.

Constraints:
The rules you have to follow as part of your optimization. For example, in our personal lives, 
we have constraints, or limits, including affordability, time available, family schedules, etc. 
Constraints are any limitations you need to place on the variables that you want to optimize.

2

3

Input parameters:
The given data/information relevant to your problem and variables, such as cost of producing 
each SKU, weight of parcels, dimensions of items you put on the shelves etc. These input 
parameters help to build your model formulation appropriately for the specific real life 
problem instance.

4

Objective/Goals:
The results you must obtain as part of the optimization and the driver to your success. 
Typically, optimizations are performed to either minimize or maximize a specific variable, 
and often with multiple objectives: minimizing one variable, and maximizing another. For 
example, in business you may want to minimize costs and time (i.e., delivery, downtime, 
etc.) You may want to maximize profit margins, margins/individual SKUs on products, or 
on-time deliveries.
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You will be working with our Qatalyst software, which is designed to solve optimization problems 
on both classical or quantum computers.

In this document, we will present three mathematical problems. You will translate these 
problems  into proper Qatalyst data structures and then submit them through the function call 
qatalyst.qcore.sample_constraint_problem. Important: You will only have access to QPUs 
(Quantum Processing Unit) for the third problem, after you have successfully solved the first 
two problems on a CPU. We will also provide one additional problem that is not guided by the 
Training Videos for you to solve on a QPU.

The documentation for installing and using the library can be found here. 

Qatalyst uses Python and Numpy. More specifically you will need to use Numpy arrays/matrices for 
two of the most important parameters in the function mentioned above. So if you are not familiar 
with these, you can take a look at these pages: a matrix of zeros, a matrix of ones. 

We do not expect you to spend over three hours working on these problems. If there is anything 
that is confusing or not clear, please let us know. 

Your coursebook contains links to  Qatalyst documentation, as well as supplementary 
documentation specific to these problems.

A member of the QCI team will set up your Qatalyst account. You will receive your Qatalyst token 
in your email.

Step-by-step instructions for installing QCI’s Qatalyst software can be found here, or follow the 
instructions below.

Your First Problem

Setting Up Qatalyst:

Step 1:
We recommend downloading Anaconda, but if you have Python and Numpy or Scipy already, 
that works just fine! You can download and install Python here.

Installing Python, NumPy/SciPy and Qatalyst:

Step 2:
For mac users search and open ‘Terminal’. For windows users, search and open 
‘Command Prompt’.

Step 3:
Type
pip3 install qatalyst

9

https://docs.qci-prod.com/reference/qcore_solvers/generated/qatalyst.qcore.sample_constraint_problem.html#qatalyst.qcore.sample_constraint_problem
https://docs.qci-prod.com/installation.html
https://numpy.org/doc/stable/reference/generated/numpy.zeros.html
https://numpy.org/doc/stable/reference/generated/numpy.ones.html
https://docs.qci-prod.com/installation.html
https://www.anaconda.com/products/individual
https://www.python.org/downloads/


Once you have a Qatalyst account, you will be given an access token. The token goes into a .conf file 
and enables access to Qatalyst. The documentation for installing the client software, setting up 
the .conf file, and using Qatalyst is located here

You can either manually create the configuration file, or you can download it, and skip a couple of 
steps. You can find the instructions for both options below. 

Setting up your Token:

Unzip the file in your Finder.1

Right click the file.

Select ‘Open With’ > TextEdit

2

Replace “<your-access-token>” with the specific access token that was emailed to you.4

Click on ‘File’ on the top left of your screen, and ‘Save’5

Move the file into your User folder. (This folder is named after your macbook username and 
should already be in your computer.)

6

Right click the file.7

Click ‘Get Info’

Under “Name & Extension”, change “qci.conf” to “.qci.conf”.

You’ve now successfully completed the setup of your Qatalyst token! 

8

9

10

3

Locate the file in your Downloads.1

Unzip the file.

Open the file on ‘Notepad’

2

Replace “<your-access-token>” with the specific access token that was emailed to you.4

Click on ‘File’ on the top left of your screen, and ‘Save’5

Move the file into C:\Users\Username\6

Right click the file.7

Click ‘Rename’ and change “qci.conf” to “.qci.conf”.

You’ve now successfully completed the setup of your Qatalyst token! 

8
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With Downloaded File:

For Macs:

For Windows:

Download the file here.1
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Manually:

Search and open “IDLE” (this should come with your Python download).

For Macs:

1

Click “File” on the top left hand corner of your screen, then click New File.2

Replace “<your-access-token>” with the specific access token that was emailed to you.4

CLick File > Save As >5

Name file “qci”.6

Select the destination folder as your User folder. (This folder is named after your macbook 
username and should already be in your computer.) Then click ‘Save’.

7

Open Finder>User folder.8

Find the file you just created and right click on it.9

Click ‘Get Info’.10

11 Under “Name & Extension” Change “qci.py” to “.qci.conf”.
12 You’ve now successfully completed the setup of your Qatalyst token! 

3 Then type:
default:
access_token: <your-access-token>
sampler: csample

Open Notepad.

For PC

1

2

Replace “<your-access-token>” with the specific access token that was emailed to you.

4 CLick File > Save As >

5 Name file “qci”.

6 Save in the following location: C:\Users\Username

7 Open the folder where you saved the file.

3

Then type:
default:
access_token: <your-access-token>
sampler: csample

Find the file you just created.

Right click on the file. > Rename.

Change “qci.py” to “.qci.conf”

You’ve now successfully completed the setup of your Qatalyst token!

8 Click on the View tab on the top left of your screen. Make sure that the ‘File name extensions’ 
is checked.

9

10

11
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Congratulations! You have now successfully installed Qatalyst and set up your token.



Consider the following function:

Which X variables should be set to one to obtain the lowest value of y?
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Problem Set  
Problem 11

y = X1 + 2X2 + X1X2 (1)

Consider same function as above:

But now we have some restrictions for the variables:

What combination of X variables that satisfy the constraints gives the lowest value for y?

What combination of X variables that satisfy the constraints gives the lowest value for y?

Problem 22

Consider the constraints:

And the function:

Problem 3 - this problem is to be solved on a QPU.3

y = X1 + 2X2 + X1X2

X1 + X3= 1

y = X1X3 −3X1X2

2X1+ 2X2= 2

2X1 + 2X2 = 2

(2)

(3)

(4)

(5)

(6)

Consider the constraints:

What combination of X variables that satisfy the constraints gives the lowest value for y? (Be 
careful and check the answer you obtain)

Solutions for these problems can be found at the end of the coursebook. For the best learning experience, 
try not to peek! We encourage you to reach out if you encounter any problem.

And the function:

Problem 4 - (optional)4

X1 + X3 = 1, 

X2 + X4 = 1, 

X1 + X2 = 1 

y = X1X3 −3X1X2 + 4X4 

(4)

(5)

(6)

(7)

Note that the X variables below are binaries.

Note that the X variables below are binaries.

Note that the X variables below are binaries.

Note that the X variables below are binaries.

Janmae Pagador

Janmae Pagador

Janmae Pagador

Janmae Pagador

Janmae Pagador
above

Janmae Pagador
above

Janmae Pagador
above

Janmae Pagador
above



Objective Explainer: https://youtu.be/AyqwusiNaa4
Constraints Explainer: https://youtu.be/PKDvX5Ds8ew

In the following videos, we will show you how to code your solutions. You may use any platform you 
prefer to run Python. Please note that these three problem videos will not show you how to run 
Qatalyst. Also note that these problems are run on a classical computer, often referred to as “CPUs”, 
in the following videos. The  QPU Access video will demonstrate how to solve Problem 3 with 
Qatalyst. Tip: Referencing the above background videos will help you gain a deeper understanding when 
it comes to solving these problems.

This problem explains how to transcribe an objective matrix into a numpy array. It solves the 
first problem in the QUBT U tutorial worksheet.

Problem 11

Training Videos

https://youtu.be/05u5B9eqQeQ

This problem explains how to transcribe a constraint and objective matrix into a numpy 
array. It solves the second problem in the QUBT U tutorial worksheet.

Problem 22

https://youtu.be/V7KdfjmRURI

This problem helps consolidate your knowledge on numpy arrays and Qatalyst by transcribing 
bigger constraints and objective matrices into numpy arrays. A demonstration  of this 
problem using a quantum computer can be found in the next video.

Problem 13

https://youtu.be/vXqyk2hv8-I

A demonstration of QPU access will be shown here.

QPU Access:
https://youtu.be/nHUciljRhLo
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For Your Own Knowledge

Problem Walkthroughs

https://youtu.be/AyqwusiNaa4
https://youtu.be/05u5B9eqQeQ
https://youtu.be/PKDvX5Ds8ew
https://youtu.be/V7KdfjmRURI
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https://youtu.be/nHUciljRhLo


To Begin -  to access complete Qatalyst documentation, click here.

Documentation

Constraint matrix

1. SUPPLEMENTAL DOCUMENTATION

Constraint equations are made of a linear combination of binary variables from a problem, 
the most general form being BX1 + CX2 + DX3 + ... + A = 0. The amount of constraint equations will 
depend on the problem, and for each equation we will allocate a row in our constraint matrix. 
Each column of the matrix will represent a unique variable from the constraints, plus an extra 
column on the right for the constant. Thus, if we have N unique variables and M constraints, 
we will need to build a M x (N+1) matrix. 

To be able to translate a constraint into a matrix row, it must be able to fit the format 
shown in the example below, where the entries of the matrix would be the coefficients.

This matrix is symmetric, which means we need to include the terms with two variables 
twice in the matrix. Since we are taking them into account twice, each coefficient needs to 
be divided by two as follows:

1.1

Objective Function
The function sample constraint problem() takes two required parameters as stated in the 
documentation. The first one being the objective matrix. 

The objective is a squared matrix that represents a quadratic polynomial which the user 
wants to minimize. For example, if a user has a problem with three variables (X1, X2 and X3), 
they are able to minimize any polynomial in the form A*X1 +B *X1X2 +C *X1X3 +D *X2 +E *X2X3 +F *X3 
Note that terms of the form X2

i are not included because the variables are binary, which means 
X2

i = Xi (Because 12 = 1, and 02 = 0). 

To represent this polynomial as a squared matrix, we plug in the coefficients with only one 
variable on the diagonal.

1.2
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Putting it all together, a quadratic polynomial can be represented in an objective matrix 
as follows:

Reading qatalyst.result.Result()
The function sample_constraint_problem() returns an object Result() with the answers to 
the optimization problem sent.  This object possesses two attributes that will be useful for 
these problems; “samples” and“energies”.

Result().samples contains a list of the answers to the specified constraints and objective 
function. For example, if a user sends a two variable problem and obtains in 
Results().samples[0] an array looking like this: [1,0] it represents an answer where X1 is set to 
1 and X2 is set to 0.

Results().energies returns a list with the “energy” for each corresponding solution. The 
energy of a solution is a real number calculated from a sum of all the constraints squared plus 
the objective function. If a problem is composed of only an objective  function  (no  
constraints)  then the energy of a solution corresponds to said solution plugged into the 
objective function.

For  example, if we have a problem with a constraint X1 + X2 - 1 = 0, and objective function 
y(X1,X2) then the energy will be equal to y(X1,X2) + α(X1 + X2 - 1)2.

The  alpha  value  in  the  equation  above,  is  a  float  parameter  that  can  be passed  to  the  
sample constraint problem()  function,  it  is  by  default  set  to  1. This parameter determines 
how much the energy will be affected for solutions that do not satisfy the constraints.  If you 
are not interested in such solutions, it is recommendable to set the alpha parameter to a 
higher value.  This is because the energy results are sorted in ascending order, so the higher 
the alpha parameter, the more likely solutions that satisfy the constraints show up first (if 
they exist).

1.3

response = qcore.sample_constraint_problem(obj, constr)
print(response.samples[0])
print(response.energies[0])

Code example:

The code above will print the first solution and its corresponding energy to the problem 
defined by the constraints in the “constr” matrix and the objective function stored in the 
“obj” matrix. This is also the best solution found so far and has the lowest energy, compared 
to other solutions.

15
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A constraint can be thought of as a rule, or a requirement that must be met, for a solution to 
be considered viable. For example, when planning a schedule, one person cannot be in two 
places at once. Or, there could be certain tasks that must be completed in a given time frame. 
Both of these are constraints, due to the nature of them being required.

 Constrained Optimization FAQs

What is a constraint?

An objective function is any function dependent on some variables which we wish to find the 
combination of variables that would give us the lowest value for the function. In Qatalyst, we 
only work with quadratic functions where the variables are binary. Quadratic means that 
each term can have at maximum a combination of two variables, and binary that these 
variables can only take the values of zero or one.

What is an objective function?

The API submits a matrix of constraints and objectives, which is actually a feeder to create a 
QUBO matrix.

What is a QUBO API matrix?

Qatalyst is focused on solving optimization problems. For example, a common optimization 
problem is the Traveling Salesman,where one entity must visit a list of locations at least 
once. The locations could be every U.S. state capitol, or every Home Depot in a state. The goal 
of the problem is to find the minimum distance needed to travel,  or in essence, optimize the 
distance. However, distance is not the only factor to optimize. Another optimization problem 
could be finding the lowest cost of production for a set of factories, or the most efficient way 
to schedule tasks among workers. The possibilities are truly endless. Another problem might 
be finding community clusters, such as we’ve seen with Covid transmission.

What kinds of problems in the real world can I solve with QUBT U’s 
practice problems?

Think of an objective like a goal. For example, a person might want to make a cake. Yet, they 
also would like to make the cake in the most cost effective way possible. However, to make 
said cake there are  some requirements, or rules: mainly the recipe. It would be cheaper to 
make the cake without eggs and flour, however, they are required to complete the recipe. The 
cost would be lower without turning on the oven, but baking is an integral step.

Finally, the variables are the individual ingredients, and the amounts used. Perhaps there is 
a gluten free substitute that  costs more. If the cake does not need to be gluten free, the 
optimal result will not include that ingredient. The variable for eggs would tell how many 
eggs to include in the cake, or the variable for flour how many cups to mix in. To summarize, 
objectives can be considered to be the end goal, while the constraint(s) being the required 
condition(s) to get there. The variables then are the individual actions taken along the route. 

What is the relevance of the components in the Q API matrix? (Constraint, 
objective, variable)

16



Quantum computers take advantage of quantum phenomena like superposition and entanglement, 
which allows us to solve certain problems in less steps than a classical computer. One important 
class of problems that quantum computers are believed to solve faster are optimization problems. 
These problems are of great importance for many applications, ranging from supply chain and 
logistics to employee scheduling to financial analysis.  

Why solve problems with quantum computers?

Each constraint equation represents a row in the matrix. Each variable represents a column 
in the matrix, but we also have to include an extra column on the right for the constant value. 
This means that if we have N unique variables and M constraint equations, we will need to 
build a M x (N+1) matrix. The entries in the matrix correspond to the coefficients of the 
variables. Consider the following example with two variables and two constraints:

Here X1 and X2 are the binary variables, note that the first constraint only contains one 
variable and this is why there is a 0 in its place in the matrix. Make sure that your constraint 
equation is equal to zero in order to build a constraint matrix following the example above.

How do I turn constraints into a constraint matrix?

This is a property of binary variables, 1 * 1 = 1 and 0 * 0 = 0. Because 1 * 1 = 1 and 0 * 0 = 0. 
Because of this, you will not see many squared terms in our documentation or examples, since 
we can simplify them by removing the square.

Why is X2 = X ?

How do I turn an objective function into an objective matrix/QUBO?

Consider the most general form of a binary variable quadratic function:

To represent this as a QUBO, we plug in the coefficients that correspond to terms containing 
only one variable in the diagonal entries

AX1+BX1X2 + CX1X3+ DX2+ EX2X3 + F X3
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Terms that contain two variables will be included in the off diagonal terms. QUBOs are 
symmetric, which means that we will include coefficients from terms with more than one 
variable twice. Because of this, we need to divide these coefficients by 2. The matrix entry i,j 
will hold the coefficient corresponding to the term that contains the variables XiXj as such:

Putting it all together, a QUBO or objective matrix can be built as follows:

Why am I obtaining answers that do not satisfy the constraints?

Under the hood Qatalyst does not treat constraints as actual restrictions. In fact, at the very 
core, every problem is reduced to a QUBO problem, in which the U stands for “Unconstrained”. 
Qatalyst uses some mathematical tricks to give preference to the solutions that satisfy the 
constraints, but it fundamentally solves an unconstrained problem. 

How can I obtain answers that satisfy the constraints?

The function sample_constraint_problem() takes an argument “alpha” which is set to 1 by 
default. This is called the Lagrange parameter. In short, the Lagrange parameter tells 
Qatalyst how much priority it should give to solutions that satisfy the constraints. The higher 
the alpha value, the more likely it is to obtain answers that satisfy the constraints first (if 
such solutions exist). This means that if you are not obtaining feasible solutions, increase the 
alpha value and try again.

 What is a feasible solution?

A solution is considered feasible if it satisfies all of the constraints described in the 
constraint matrix.

What can I do if I am only interested in answers that are feasible?

The function sample_constraint_problem() takes an argument “alpha” which is set to 1 by 
default. This is called the Lagrange parameter. In short, the Lagrange parameter tells 
Qatalyst how much priority it should give to feasible solutions. The higher the alpha value, 
the more likely it is to obtain feasible solutions first (if such solutions exist). In other words,  
if you are not obtaining feasible solutions at the top of the results list,  increase the alpha 
value and try again.

Additionally, the results returned by Qatalyst contain an attribute called “is_feasible”. This 
attribute contains a list of boolean values which indicate the feasibility of each solution 
returned. For example, if the first value in the list is set to 1 (True), then the first solution 
satisfies all the constraints. Below is a code example of how to print only feasible solutions:

18

results = qcore.sample_constraint_problem(...)

for i in range(results.samples):
    If results.is_feasible[i]:
        print(results.samples[i])



After the problems are solved, we’ll add more information with webinars to help you apply 
Qatalyst and constrained optimization.  Below are a few ideas, but we want student feedback for 
each course session.

Webinars

Real World Story Problems:
Creating the complex programs and low level coding demanded by quantum computers and 
development kits is a most difficult part of quantum computing. Qatalyst eliminates that 
requirement, so you can simply solve your problems. That requires transforming know as, 
like the example above about Amazon,  into a mathematic equation, and then forming the Q 
API matrix API call. We’ll show  you how to transform a real world problem into a Qatalyst 
API call, then solve it, applying what you learned with the problems/exercises.  

Quantum Computing Hardware Overview:
Quantum computers apply quantum mechanics to our real world problems and simulations. 
That means that nothing about the way they operate is the same as today’s systems. It’s 
important to understand the ins and outs of quantum hardware for the future. We’ll share 
the critical details you need to know to be quantum literate.

Quantum Programming Overview:
Quantum programming is nothing like today’s programming. It’s as different as the abacus 
is from a computer. We’ll review the basics of quantum programming for gate models and 
annealers, sharing the steps and requirements to create your own quantum programs, at a 
high level. We can also review a few details about Qiskit, a leading open source development 
kit for complex quantum programming.

1

2

3

19



If you have questions about the problems, Qatalyst or your results, please email

qubt-u@quantumcomputinginc.com 

You can also join our QUBT U community on Facebook here. We’ll share quantum news and 
information, answer questions, and empower QUBT U students to share and learn from each other. 

We also want your feedback.  Please go here to share your experiences, ideas for more things you’d 
like to learn and any other feedback you’d care to share. All feedback will remain confidential.

Support and Community 
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http://www.facebook.com/groups/qubtu/
https://www.quantumcomputinginc.com/qubt-u-feedback/


Solutions

Answer: [0 0]
from qatalyst import qcore
import numpy as np

*Note: Here's a solution using Qatalyst API's function sample_qubo*

def problem_1_QUBO():

 Objective is x1 + 2 x2 + x1 x2
 obj = np.array([[1, 1/2], [1/2, 2]])

 response = qcore.sample_qubo(obj)

 for i in range(len(response.samples)):

  sample = response.samples[i]
  energy = response.energies[i]
  print(sample, energy)

problem_1_QUBO()

*Note: Alternatively here's a solution using Qatalyst API's function 
“sample_constraint_problem"*

def problem_1_constraint():

 #When there are no constraints, a matrix of 0s works
 constraint = np.array([[0,0,0]])

 # Objective is x1 + 2 x2 + x1 x2
 obj = np.array([[1, 1/2], [1/2, 2]])

 response = qcore.sample_constraint_problem(obj, constraint)

 for i in range(len(response.samples)):

     sample = response.samples[i]
     energy = response.energies[i]
     print(sample, energy)

problem_1_constraint()

1
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Answer: [1 0]
from qatalyst import qcore
import numpy as np

def problem_2():

 constraint = np.array([[2,2,-2]])

 # Objective is x1 + 2 x2 + x1 x2
 obj = np.array([[1, 1/2], [1/2, 2]])

 response = qcore.sample_constraint_problem(obj, constraint)

 for i in range(len(response.samples)):

  sample = response.samples[i]
  energy = response.energies[i]
  print(sample, energy)
problem_2()

2

Answer: [0 1 1] or [1 0 0]
from qatalyst import qcore
import numpy as np

def problem_3():

 constraint = np.array([[1,0,1,-1],[2,2,0,-2]])

 # Objective is x1x3 -3x1x2 
 obj = np.array([[0, -1.5, 1/2], [-1.5, 0, 0], [1/2, 0, 0]])

 response = qcore.sample_constraint_problem(obj, constraint)

 for i in range(len(response.samples)):

  sample = response.samples[i]
  energy = response.energies[i]
  print(sample, energy)
problem_3()

3
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Answer [0 1 1 0]

from qatalyst import qcore
import numpy as np

def problem_4():

 constraint = np.array([[1,0,1,0,-1],[0,1,0,1,-1],[1,1,0,0,-1]])

 # Objective is x1x3 -3x1x2 + 4x4
 obj = np.array([[0, -1.5, 0, 0], [-1.5, 0, 0, 0], [0, 0, 0, 0], [0, 0, 0, 4]])

 lagrange = 4
 response = qcore.sample_constraint_problem(obj, constraint, alpha=lagrange)

 for i in range(len(response.samples)):

  sample = response.samples[i]
  energy = response.energies[i]
  print(sample, energy)

problem_4()

4
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obj = np.array([[0, -1.5, .5, 0], [-1.5, 0, 0, 0], [.5, 0, 0, 0], [0, 0, 0, 4]])




